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Welcome to RocLab! 
 
RocLab is a software program for determining rock mass strength 
parameters, based on the generalized Hoek-Brown failure criterion. 
 
RocLab is a product of Rocscience Inc. It is a free software program. 
 

 
 
Rocscience produces many other software products for geotechnical, 
mining and civil engineering applications. Visit www.rocscience.com 
to find out about the many other software products available from 
Rocscience. 
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Introduction 
 

One of the major obstacles which is encountered in the field of 
numerical modeling for rock mechanics, is the problem of data input 
for rock mass properties. 

The usefulness of elaborate constitutive models, and powerful 
numerical analysis programs, is greatly limited, if the analyst does not 
have reliable input data for rock mass properties. 

The latest version of the Hoek-Brown failure criterion (Ref.1), in 
conjunction with its implementation in the software program 
RocLab, goes a long way toward remedying this situation.  

Some formerly troublesome issues with the failure criterion have now 
been resolved, including: 

• the applicability of the criterion to very weak rock masses, and  

• the calculation of equivalent Mohr-Coulomb parameters, from the 
Hoek-Brown failure envelope 

The program RocLab provides a simple and intuitive implementation 
of the Hoek-Brown failure criterion, allowing users to easily obtain 
reliable estimates of rock mass properties, and to visualize the effects 
of changing rock mass parameters, on the failure envelopes. 

The task of determining rock mass properties is not usually an end in 
itself. It is carried out in order to provide input for numerical analysis 
programs, which require material properties in order to perform a 
stability or stress analysis.  

The rock mass properties determined by RocLab can be used as input 
for numerical analysis programs such as Phase2 (finite element 
stress analysis and support design for excavations) or Slide (limit 
equilibrium slope stability analysis). Phase2 and Slide are also 
available from Rocscience. 
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Documentation 
 
The calculations in the RocLab program, are based on the latest 
version of the Generalized Hoek-Brown failure criterion, as detailed in 
the following paper (Ref. 1): 
 

Hoek, E., Carranza-Torres, C.T., and Corkum, B. (2002), Hoek-
Brown failure criterion – 2002 edition. Proc. North American 
Rock Mechanics Society meeting in Toronto in July 2002 

 
The program RocLab incorporates all of the latest developments 
described in this paper.  
 
The paper should be read by all users of RocLab!!! The definitions 
and equations for all input and output parameters in RocLab, can be 
found in this paper, which is available as a PDF document. 
 
Another useful document is the following (Ref. 2): 
 

“A Brief History of the Hoek-Brown Failure Criterion”, by Evert 
Hoek. 

 
This paper provides a brief chronological overview of the evolution of 
the Hoek-Brown failure criterion, and provides references to all of the 
significant papers which have been published. This is also 
recommended reading for all users of RocLab. The paper is available 
as a PDF document. 
 
Finally, a set of notes by Dr. Evert Hoek, Practical Rock Engineering, 
(Ref. 3) is available on the Rocscience website, www.rocscience.com , 
in the form of a series of PDF documents. Practical Rock Engineering 
is recommended reading for all students of rock mechanics. Chapter 
11 (Rock mass properties) should also be read by users of RocLab. 
Note that the version of the Hoek-Brown failure criterion which is 
presented in the current version of Practical Rock Engineering, has 
been superceded by the latest version of the criterion (Ref. 1). 
However, the conceptual information is still relevant, and gives 
further insight into the development of the Hoek-Brown criterion. 
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How Can I Use RocLab? 
 
The following tasks can be accomplished with RocLab. 

Determine Strength Parameters 
Determine the Generalized Hoek-Brown strength parameters of a rock 
mass (mb, s and a), based on the following input data: 
• unconfined compressive strength of intact rock sigci 
• the intact rock parameter mi  
• the geological strength index GSI 
• the disturbance factor D 

Plot Failure Envelopes 
Plot the Hoek-Brown failure envelope in principal and / or shear-
normal stress space. 
• Interactively change sigci, GSI, mi, D, to see how the failure 

envelope changes with each parameter 

Estimation of Input Parameters 
Each of the above 4 input parameters (sigci, mi, GSI and D), can be 
conveniently estimated from built-in charts and tables, based on rock 
type, geological conditions, etc. 

Triaxial Lab Test Data 
Triaxial lab tests on intact rock, can be used to determine sigci and 
mi using the Marquardt-Levenberg fitting technique. 
• the triaxial data can be imported from Microsoft Excel through the 

clipboard, tab-delimited or comma separated value text files, 
RocData or other RocLab files.  

• the data can also be entered in the program using a built-in 
spreadsheet. 

Equivalent Mohr-Coulomb Parameters 
Calculation of equivalent Mohr-Coulomb strength parameters 
(cohesion and friction angle).  
• The best-fit Mohr-Coulomb strength envelope is determined over a 

stress range that you can define based on your application (i.e. 
tunneling or slope stability). 

• Plot the equivalent Mohr-Coulomb failure envelope in principal 
and / or shear-normal stress space 
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Stress Sampler 
Graphically sample the Hoek-Brown or Mohr-Coulomb failure 
envelope to determine strength for any discrete value of stress 
(principal, shear or normal stress). 

Instantaneous MC Sampler 
Graphically determine the instantaneous Mohr-Coulomb parameters 
at any point along the Hoek-Brown failure envelopes. 

Other Rock Mass Parameters 
The program also calculates rock-mass parameters such as tensile 
strength, uniaxial compressive strength and deformation modulus. 

Units 
A RocLab analysis can be carried out using either Metric or Imperial 
units. In Metric, the stress units are Megapascals (MPa). In Imperial, 
the stress units may be either Kilopounds per square foot (ksf) or 
Kilopounds per square inch (ksi). The unit system is selected in the 
Project Settings dialog. 

Export Data / Images 
Export data for further analysis or report writing: 
• Copy the data and / or plots to the clipboard for easy import into 

Microsoft Word or your favorite word processor or image editing 
program. 

• Copy the data and / or plots directly into Microsoft Excel. 
• Save the plots to a JPEG or BMP image file. 
• Print and Print Preview capabilities. 

Display Options 
Numerous Display Options to customize the appearance of your plots: 
• Change colors, fonts, line thickness. 
• Grid overlay. 
• Add plot title and show input data directly on plots. 
• Zooming. 
• Plot Mogi’s line (transition from brittle to ductile failure). 
• Grayscale for output to black and white printers 
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Quick Tour of RocLab 
 
The following “quick tour” of RocLab will familiarize the user with the 
features of the program. 
 

Entering Input Data 
 
The primary means of user interaction with RocLab, is with the 
sidebar data input area, shown below. The sidebar is used for data 
input, and also for display of calculated output parameters. 

 
There are various methods of entering the 
input data for RocLab: 

Interactive Data Input 
 
• If you click on the  arrows with the 

mouse, to change the input data, the 
RocLab calculations are instantly 
performed. All output data is 
immediately recalculated, and the failure 
envelope plots are redrawn, each time 
the mouse is clicked on either the up or 
the down arrow. 

 

 

This allows you to interactively observe the 
effect of parameter changes, on the shape of 
the failure envelopes, and the output values. 
 

Pick Dialogs 
 
• You may also enter input parameters 

using the “Pick” dialogs. When you select 
a Pick button,  you will be presented 
with another dialog, in the form of a 
chart or table, which allows you to 

estimate a value of the input parameter. When you select OK in 
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the Pick dialog, the selected value of the parameter will be loaded
into the sidebar data input area, the RocLab calculation will 
automatically be carried out, and all output data and failure 
envelopes will be updated.  

 

 

Keyboard Entry 

 If you type the numbers in the sidebar edit boxes with the 
ied out. 

 

Triaxial Lab Test Data 

 You may also determine values of sigci and mi, from triaxial lab 

r 
b 

 
•

keyboard, then the calculations are NOT automatically carr
In this case, you must select the Compute option (available in the 
sidebar, the toolbar, or the Analysis menu), in order to re-compute 
the rock mass parameters and failure envelopes. 

 
•

test data for intact rock. This is done with the Use Lab Data 
option, as described in a later section. When you select Apply o
OK in the “Calculate sigci, mi from Lab Data” dialog, the RocLa
calculation is carried out, and all output values and failure 
envelopes are updated. 
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Estimating Input Parameters 
 
Each of the parameters used as input for the Hoek-Brown criterion – 
sigci, mi, GSI and D – can be estimated using convenient charts and 
tables built into RocLab. 
 
These charts and tables are accessed by selecting the “Pick” button   
located beside each of the input parameter edit boxes in the sidebar. 
 

 
 
When you select a Pick button, a table or chart will appear, allowing 
you to determine a suitable value for the desired parameter. For 
example, the dialogs for estimation of mi and GSI (Rock Type = 
General) are shown below. 
 

 
 
Once you have determined a value, select OK in the Pick dialog. The 
value will be automatically loaded into the sidebar input data area, 
and the RocLab calculation will automatically be carried out (ie. 
output parameters and failure envelopes will be re-calculated using 
the selected input data). 
 

 9



 
 
GSI chart (Rock Type = General) 
 
Select the Pick button for each of sigci, mi, GSI and D, and 
experiment with the dialogs. 
 
Notice that there are TWO distinct GSI charts: 
 
• One for general rock mass types 
• One for weak, heterogeneous rock mass types such as flysch, which 

extends the useful range of GSI down to values as low as 5. 
 
For further information about the Hoek-Brown classification 
parameters sigci, mi, GSI and D, please consult Ref.1. 
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Failure Envelope Plots 
 
RocLab will plot the rock mass failure envelopes in: 
 
• Principal stress space (sigma1 vs. sigma3) 
• Shear – Normal stress space (sigma normal vs. Tau) 
 
The plots correspond to the current data in the sidebar. 
 

 
 
By default, BOTH principal stress AND shear-normal plots are 
displayed. However, you can choose to display either plot type on its 
own, by selecting the desired plot type from the toolbar, the Analysis 
menu or the right-click menu. 
 
Various display and analysis options are available, such as: 
 
• Display equivalent Mohr-Coulomb envelope 
• Stress sampler / Instantaneous Mohr-Coulomb sampler 
• Customize plot appearance with Display Options (eg. grid overlay, 

line thickness, fonts etc), and zooming 
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Right Click Menu 
s, are also conveniently available 

u, if you right-click the mouse anywhere in the 

oek-Brown Parameters 

TIP – most of the plot display option
in the right-click men
plot display area. 
 

H
 
For a given set of input parameters (sigci, GSI, mi and D), RocLab 
alculates the parameters of the generalized Hoek-Brown failure 

e sidebar, as shown below. The Hoek-Brown 
ilure envelopes which are plotted in RocLab, are generated using 

c
criterion (mb, s and a).  
 
These are displayed in th
fa
these values of mb, s and a. 
 

 
 
These parameters are calculated using the latest version of the Hoek-

rown failure criterion. For a definition of these parameters, and the B
equations which define them, please see Ref. 1. 
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Equivalent Mohr-Coulomb Parameters 
 
In addition to the Hoek-Brown failure criterion parameters (mb, s and 
a), RocLab always calculates equivalent Mohr-Coulomb parameters 
(cohesion and friction angle) for the rock mass. 

Since most rock engineering software is still written in terms of the 
Mohr-Coulomb failure criterion, the calculation of equivalent Mohr-
Coulomb parameters from the Hoek-Brown failure criterion, is an 
important feature of the RocLab program. 

 

The corresponding Mohr-Coulomb envelope can be viewed by selecting 
the Mohr-Coulomb Envelope option from the toolbar or the Analysis 
menu. 

Failure Envelope Range 
It is important to note that the Failure Envelope Range option has 
a direct effect on the calculated Mohr-Coulomb parameters. 

• For details about the Mohr-Coulomb fitting procedure, and the 
significance of the Failure Envelope Range option, see Ref. 1 
(section 4: Mohr-Coulomb Criterion, and section 6: Determination 
of max3σ ′  ) 

• When the Failure Envelope Range option = General, notice that 
sigma3max = sigci / 4. This is based on the empirical observation 
that the stress range associated with brittle failure, occurs when 
sigma3 is less than about one-quarter of sigci.  

• When the Failure Envelope Range option = Custom, you may enter 
any value of sigma3max.  

• The Failure Envelope Range has NO effect on the calculated Hoek-
Brown parameters. 
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Other Rock Mass Parameters 
 
At the bottom of the sidebar, you will notice that the following rock 
mass parameters are also calculated: 
 
• Sigt (rock mass tensile strength) 
• Sigc (uniaxial rock mass compressive strength) 
• Sigcm (global rock mass compressive strength) 
• Em (rock mass modulus of deformation) 
 

 
 
For the definitions of these parameters, and the equations used to 
calculate them, please see Ref. 1. 
 
In particular, you will notice that there are two values of rock mass 
compressive strength which are calculated by RocLab – sigc and 
sigcm. For a discussion of how these two parameters are defined, and 
how they may be used, please see Ref. 1 – section 5: Rock Mass 
Strength. 
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Triaxial Lab Test Data 
 
Another feature of RocLab, is the ability to input triaxial lab test 
data (sigma1 / sigma3 data pairs), in order to determine the intact 
rock parameters sigci and mi. This is done as follows: 
 
1. Select the Use Lab Data option from the Analysis menu or the 

toolbar. 
2. The data can be entered in a spreadsheet, or imported from a file, 

as shown in the dialog below. 
3. A curve fit is then performed on the data, using the Marquardt-

Levenberg fitting technique, and values of sigci and mi are 
obtained. 

4. After entering the data, select OK in the dialog, and the calculated 
values of sigci and mi will be used to calculate the Hoek-Brown 
strength parameters and failure envelopes. 

 

 
 
Obtaining actual values of sigci and mi from triaxial lab test data, is 
of course always recommended, if such data is available. It should be 
emphasized that a large number of test results is not always 
necessary, and good results can be obtained from a relatively small 
number of data points (eg. 6 or 7 triaxial tests). 
 
If triaxial lab data is not available, values of sigci and mi can always 
be estimated in RocLab, using the Pick dialogs described previously. 
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Example 1 – Tunnel, undisturbed (D = 0) 
 
Consider an undisturbed in situ rock mass surrounding a tunnel at a 
depth of 100 meters, with the following Hoek-Brown classification 
parameters. 
 

 
 
Enter this data in the sidebar input data area. Also, enter the 
following data to determine the Failure Envelope Range (sig3max). 
This is used for the equivalent Mohr-Coulomb calculation: 
 

 
 
Now press Compute. 
 
The resulting output will be displayed in the sidebar, and the failure 
envelopes will be calculated. 
 
Notice the equivalent Mohr-Coulomb parameters which have been 
calculated: 
 

 
 
The envelope corresponding to these parameters, can be viewed on the 
plots, by selecting the Mohr-Coulomb strength envelope option, from 
the toolbar or the Analysis menu. 
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To get a better look at the MC envelope, let’s view only the Normal vs. 
Shear stress plot. Select the Normal vs. Shear Stress option from the 
Analysis menu or the toolbar. This will hide the principal stress plot, 
and show only the Normal vs Shear stress plot, maximized in the 
view. 
 

 
If you examine the MC envelope, you can graphically confirm the 
calculated values of cohesion, friction angle, and also the rock mass 
tensile strength sigt. The tensile strength is the negative value of 
normal stress, at the origin of the failure envelope. 
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Example 2 – Slope, disturbed (D = 1)  
 
Consider a rock mass with the same basic parameters as the previous 
example, but in a highly disturbed slope of 100 meters height, with a 
disturbance factor D = 1. 
 
Enter disturbance factor D = 1. 
 

 
 
Enter the following data to determine the Failure Envelope Range 
(sig3max): 
 

 
 
Now press Compute. 
 
The resulting output will be displayed in the sidebar, and the failure 
envelopes will be calculated. 
 
Notice the equivalent Mohr-Coulomb parameters which have been 
calculated: 
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Compare the equivalent Mohr-Coulomb parameters and envelopes, 
calculated in Example 1 and Example 2. This demonstrates the 
significant effect which the disturbance factor D, can have on the 
calculated rock mass strength. 
 
For information about the Disturbance Factor, see Ref. 1 – section 7: 
Estimation of Disturbance Factor D. 
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Stress Sampler 
 
The Stress Sampler option allows the user to graphically obtain the 
exact stress coordinates at any point along the failure envelopes. This 
is done as follows: 
 
1. Select the Stress Sampler option from the toolbar, the right-click 

menu or the Analysis menu. 
2. Single click the left mouse button, at any value of sigma3 (on the 

principal stress plot), or any value of normal stress (on the shear-
normal stress plot). 

3. The stress coordinates will be displayed, corresponding to the 
value of sigma3 or normal stress, at which the mouse was clicked. 
A vertical dotted line will be displayed on the plots, to mark the 
location. 

4. Alternatively, if you click and HOLD the left mouse button on 
either of the plots, and DRAG the mouse left or right, the stress 
coordinates of the failure envelopes will be continuously displayed, 
as you move the mouse. 

5. NOTE: if the equivalent Mohr-Coulomb envelopes are also 
displayed, then the stress coordinates of BOTH the Hoek-Brown, 
and equivalent Mohr-Coulomb envelopes will be displayed. 
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Instantaneous Mohr-Coulomb Sampler 
 
The Instantaneous Mohr-Coulomb Sampler option allows the user 
to graphically obtain the instantaneous Mohr-Coulomb parameters 
(cohesion and friction angle), at any point along the Hoek-Brown 
failure envelopes. This is done as follows: 
 
1. Select the Instantaneous MC Sampler option from the toolbar, 

the right-click menu or the Analysis menu. 
2. Single click the left mouse button, at any value of sigma3 (on the 

principal stress plot), or any value of normal stress (on the shear-
normal stress plot). 

3. The instantaneous Mohr-Coulomb envelope (tangential line) will 
appear on the plots, for the value of sigma3 or normal stress, at 
which the mouse was clicked. The instantaneous values of 
cohesion and friction angle will be displayed, as well as the stress 
coordinates. A vertical dotted line will be displayed on the plots, to 
mark the location. 

4. Alternatively, if you click and HOLD the left mouse button on 
either of the plots, and DRAG the mouse left or right, the 
instantaneous Mohr-Coulomb envelope and coordinates, will be 
continuously displayed, as you move the mouse. 
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Exporting Data / Images 
 
The RocLab analysis results and failure envelope plots, can be 
exported to other programs for report writing, further analysis, etc. 
This can be done in various ways. 
 
• The Copy Data option in the sidebar or the Edit menu, will copy 

the contents of the sidebar (ie. all input and output parameters) to 
the clipboard. From the clipboard, this can be pasted into a word 
processor or spreadsheet. This provides a handy analysis 
summary. 

• The Copy option in the toolbar or the Edit menu, will copy an 
image of the current failure envelope which is displayed, to the 
clipboard. From the clipboard, this can be pasted into reports or 
image editing programs, etc. 

• The failure envelope plots can also be saved directly to a JPEG or 
BMP image file, with the Export Image File option. This is 
available in the File menu, or the right click menu. 

 

One Click Export to Excel 
The most powerful data export feature is the following – with a single 
mouse click, all data AND plots can be exported to Microsoft Excel. To 
do this: 
 
1. Select the Export to Excel toolbar button. 
2. If you have Excel installed on your computer, the Excel program 

will be automatically started, and all analysis input and output 
data will be exported to an Excel spreadsheet. 

3. Failure envelope plots will then be generated in Excel. 
4. This all takes place with a single mouse click !!! 
 
Note that the plots which are generated in Excel, correspond to the 
failure envelope plot(s) which you are currently viewing. For example, 
if you are only viewing the shear-normal plot, then only the shear-
normal data and plot, will be generated in Excel. If you are viewing 
both plots (principal stress and shear-normal), then both plots will be 
generated in Excel. Also, if the equivalent Mohr-Coulomb envelope is 
displayed, this will also be plotted in Excel. Finally, note that the 
number of data points used to create each failure envelope, is 
controlled in the Display Options dialog in RocLab. 
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Display Options 
 
The appearance of the Failure Envelope plots may be customized with 
Display Options, zooming, and other options. 
 
• Display Options is available in the toolbar, the View menu, and 

also in the right-click menu (if you right-click the mouse anywhere 
in the Failure Envelope display area). 

 

 
 
Most of the Display Options are self-explanatory, and it is left to the 
user to experiment with the options. However, we will note the 
purpose of the following options: 
 

Mogi’s Line 
Mogi’s Line defines the ratio of major and minor effective principal 
stresses at which there is a transition from brittle to ductile failure. 
This line is simply defined by sig1/sig3 = 3.4, and is plotted as a green 
line on the principal stress plot, when the Mogi’s Line option is 
selected in the Display Options dialog. 
 
• If the principal stress failure envelope lies ABOVE Mogi’s line, this 

indicates a brittle failure mode.  
• If the principal stress failure envelope lies BELOW Mogi’s line, 

this indicates a ductile failure mode. This may occur with low 
values of GSI, for example. 
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Zoom Extents 
The Zoom Extents option will automatically scale the axes of the 
failure envelopes, so that all possible failure envelopes, for the current 
value of sigci, will be visible on the plot. 
 
This corresponds to maximum values of GSI (= 100) and mi ( = 40). 
 
1. To demonstrate this, select the Zoom Extents option. 
2. Use the interactive arrow buttons, to increase the value of GSI to 

100, and the value of mi to 40. 
3. Observe the failure envelope plots. When GSI = 100 and mi = 40, 

the extent of the principal stress envelope will correspond to the 
maximum extent automatically calculated by the Zoom Extents 
option. 

 
You may find the Zoom Extents option useful for interactive 
demonstration of parameter changes on the failure envelope. 
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